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sYsTeM reQUIreMenTs
The nord sound Manager is compatible with computers running Mac 
Osx 10.6 or later, Windows xP, Windows vista, Windows 7, Windows 
8 and Windows 10.

InsTallaTIOn

UsB DrIver

 M Mac OSX users may skip this section.

The UsB driver is installed automatically together with nord sound 
Manager. If the driver for any reason needs to be manually installed 
it can also be downloaded from the nord Keyboards website and 
installed separately:

1 If you use a Windows computer (xP, vista, 7, 8 or 10), locate 
the Clavia UsB Driver v3.x setup file, downloadable from www.
nordkeyboards.com and double click it.

2 Follow the instructions on the screen.

3 after the files have been installed, the driver will be activated when 
you connect the nord instrument. Do this by connecting a UsB 
cable between the nord instrument and your computer.

4 When the nord instrument is connected to the computer, the 
driver will be automatically activated and a confirmation will appear 
in the notification area in the Windows task bar.

sOUnD ManaGer

1 Windows users: launch the “nord sound Manager v7.x setup” 
file and follow the instructions. The nord sound Manager can be 
accessed from the start menu when the installation procedure is 
finished.

2 Mac OSX users: Double-click on the “nord sound Manager 
7.x.dmg” and then drag the nord sound Manager application 
from the virtual hard drive to your “applications” folder.

 E The files mentioned for the driver and application installations 
can be downloaded from the www.nordkeyboards.com website. 
Please visit our website from time to time to check for any Nord 
Sound Manager updates.

OvervIeW  

You can manage various types of content in the nord instrument. 
Depending on the nord model, there may be Piano, sample, Organ 
Preset, Performance and Program partitions. These are accessed from 
the tabs, labeled according to the partition they represent, for example 
Piano, samp lib and Programs.

Only the appropriate tabs for each individual nord model are avail-
able. The nord Wave or C2D Organ are for instance not compatible 
with the nord Piano library which means that the Manager will not 
show a Piano tab if any of these models are used with the nord sound 
Manager.

 M Certain features in the v7 version of the Manager are exclusive to 
some models. If a Toolbar icon or a menu item is greyed out, this 
means that the instrument you use is not compatible with that 
particular  feature.

 E The actions that take place in the Nord Sound Manager will affect 
the memory in the Nord instrument. The Manager is online with a 
connected Nord at all times; any operations that you perform in 
the Manager will immediately be executed in the Nord instrument. 
If you for example delete a piano or a Program from the list in the 
Nord Sound Manager, that sound will be deleted from the Nord 
memory.

THe TOOlBar 

The Toolbar at the top of the Manager window gives you direct access 
to some of the most commonly used functions in the nord sound 
Manager. Clicking on an icon will activate its corresponding function, 
and a dialog will often appear asking for confirmation or further instruc-
tions from you.

nOrD sOUnD ManaGer

The nord sound Manager is an application which allows you to organize the various memory areas in a nord instrument. It is also used to download 
pianos, samples, programs or performances to the nord instrument or to upload any of these items - referred to as sounds - from the instrument’s 
memory to the computer hard drive. The nord sound Manager provides various methods for downloading sounds to the instrument and functions 
for backing up and restoring the entire content of a nord instrument.
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THe TaBs 

select the memory area (partition) that you wish to work with by click-
ing its tab. as an example, the Piano and samp lib tabs allow you to 
alter the content of the piano and sample partitions and the Program 
tab allows you to organize the programs of your instrument. Pianos, 
samples, programs or performances and other types will be referred to 
as “sounds” throughout this manual.

 
 Press Ctrl+Tab on the computer keyboard to cycle between the 
tabs.

The list of sounds can be ordered according to location, name, size, 
version and date, in ascending and desce  nding order. Just click on a 
headline to select a preferred view.

ParTITIOn MeMOrY InDICaTOr 

The memory indicator at the bottom of the window indicates how 
much memory is being used in the selected partition. The dark area 
shows the used memory, the bright indicates space that is available for 
new sounds.

rIGHT/CTrl-ClICKInG

If you right/Ctrl-click on a sound, a context menu will provide options, 
depending on what type of sound you selected. 

seleCT In InsTrUMenT

This will select the chosen sound in the nord 
instrument. 

UPlOaD

This will upload the selected sound from the 
nord instrument to the computer hard drive, to 
a folder of your choice.

UPlOaD TO BUnDle (PrOGraMs/PerFOrManCes)

This will upload the selected program(s) and 
any piano and/or sample that this program 
uses, to a Bundle file on the hard drive. 
Bundles are explained in greater detail on 
page 4. 

DOWnlOaD

This is only available if you right-click on 
an empty location that does not contain a sound. This allows you to 
choose a file on the hard drive, to be downloaded to the location in the 
nord instrument.

sUBsTITUTe (PIanOs & saMPles)

This feature makes it possible to substitute a piano or a sample in the 
instrument with another piano or sample from your hard drive. The pro-
cess will update all the programs that used the former piano/sample, to 
use the new one after the substitution. 

relInK (PrOGraMs) 

Use the relink feature if you want one or several selected programs to 
use another piano or sample instead of the current sound. The sound 
in question have to be present in the memory of the nord instrument. 
relinking can also be used if a piano or sample is absent in the nord 
instrument, to repair programs that are missing a component.

renaMe (PrOGraMs/PerFOrManCes)

This allows you to rename, and assign a category to a program or 
performance. Characters supported are: a-z, a-Z, 0-9 and a hyphen 
(-). The name can contain up to 16 characters. any other characters 
will not be displayed in the sound Manager lists.

 M Pianos and samples cannot be renamed, this option will not be 
available if you right-click on any of these.

DeleTe

This action will delete the selected sound(s) from the nord instrument 
memory.

FIle FOrMaTs

The nord sound Manager creates and/or uses files together with the 
nord instruments. The files are exclusive for each individual model, 
the only exception to this are the Piano- and sample library files that 
several models can use. The various types are identified by different 
icons and the file extension with a model identifier and a type in the 
following fashion: 

Type Description

.npno
Piano files from the nord Piano 
library.

.nsmp
sample files from the nord 
sample library.

ends with “p” or 
“pg”

Program and Performance 
files.

ends with “pb” 
or “bundle”

Bundle files.

ends with “s” synth program files.

ends with “op” Organ Preset files

ends with “b” Backup files.
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THe QUICK TOUr
let’s get acquainted with some of the functions in the nord sound 
Manager. If you perform the actions described in this tour, the content 
in the nord instrument may be changed, but you can always get back 
to the factory content by restoring the instrument with the Factory 
restore file, available for download from www.nordkeyboards.com. 

Backing up and restoring will be explained at the end of this tour, on 
page 6. If you have made some changes to the content of the nord  
already, now would be a great time to do a Backup.

TransFer sOUnDs TO THe nOrD

When the nord instrument leaves the factory, the Program, Perfor-
mance, Piano and the samp lib partitions are filled with sounds. In 
order to be able to try out other pianos, you can delete one or two 
pianos and load new ones and select this from the panel.

DeleTInG a sOUnD

1 Open the appropriate Tab and select a piano or a sample to delete 
and press the Delete icon in the toolbar.

You can also right-click on the sound and choose the Delete 
option or use the backspace or delete keys on the computer 
keyboard.

a dialog appears where you will be asked to confirm your intentions. If 
any programs uses the soon-to-be deleted piano (or sample), you will 
be alerted about this. If you confirm by clicking Yes, the sound in the 
nord instrument will be deleted.

 
 If you delete a piano or sample that is used by any programs, 
these programs will then be missing an important part. This can 
be fixed by downloading the same sound at a later time.

DOWnlOaD a neW sOUnD

1 Using drag and drop: Open the folder on the computer hard 
drive where the new sound is located. 

2 Make sure that the sound Manager window and the folder are 
visible on the screen.

3 Drag the new sound to the white area in the sound Manager list. 
When the cursor gets a plus-sign, release the mouse button. 

4 The Clean Deleted space process will start to prepare the 
memory and then the new piano will be downloaded to the nord 
instrument. If there isn’t enough free space to complete the opera-
tion, a message about this will appear.

 
 If the Organize view is active, you can drop a sound on any free 
location in the bank. If this is not active, the new sound will be 
automatically placed at the first free location in the bank. 

 M The pianos are categorized and can only be added to the bank 
they belong to; electric pianos cannot be added to the grand 
bank, grand’s cannot be dropped in the clavinet bank etc. 
Samples can only be added to the Samp Lib partition, Programs 
to the program etc.

1 Adding a sound using the Toolbar or Menu command: Click 
on the sound Down icon in the toolbar. The same command is 
also available in the File menu: sound Download (Ctrl-D).

2 Browse to the folder on the hard drive where the desired sound is 
located, select it and click Open. The sound will now be added to 
the bank at the first free location.

sUBsTITUTe

The substitute feature replaces a piano or sample in the nord instru-
ment with another one that you want to use. There are many different 
sample instruments available for download from the www.nordkey-
boards.com website. 

substituting a piano/sample with another will automatically update 
all the Programs that used the previous sound to use the new sound 
instead.

1 Open the Piano or sample tab. The current content of the partition 
in the nord instrument will be displayed.

2 select a sound in the list that you wish to substitute with a new 
one and click the substitute icon in the toolbar.

 
 You can also right-click the sound and choose the Substitute 
option or use the Substitute command in the Edit Menu. 

The substitute dialog informs you about the action about to take place. 
Click Browse to locate a new sound on the computer hard drive. 

3 Press Open and then confirm by clicking substitute.

The substitution will begin by deleting the original sound, then cleaning 
the memory, downloading the new sound and finally relinking all the 
programs to the new sound.

 
 If you use Susbtitute to try a sound and then change your mind, 
just substitute the new one with the previous one to get back to 
where you started from.
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relInK

relink is a powerful feature that makes it possible to change the piano 
or sample (or both) that one or several programs use. let’s imagine 
that you have downloaded a new favorite grand piano and want to 
change the programs that used your previous favorite grand, to the 
new one instead. Instead of manually changing every program on the 
instrument, relink can achieve this in the nord sound Manager. 

let’s relink a program, to change what sound(s) the program should 
use.

1 Open the Program tab and right-click a program in the list. 

2 select the relink samp lib option in the context menu. The menu 
will expand to show the sample that is linked to this program. 

3 select the sample and let go of the mouse button. This will open 
the relink dialog where you can choose the new sound that the 
program should use instead. 

4 Click relink to relink the program to the new sound.

 M You can only Relink programs to a sound that is already present in 
the Nord instrument. 

DOWnlOaD QUeUe

You can add several sounds, one by one, using the drop method, or 
with the Toolbar or Menu commands. These sounds will be put in the 
download queue. The memory will be cleaned if needed and the files 
will be downloaded to the instrument in the order they were added to 
the queue.

1 select the desired partition that holds the type of sounds that you 
wish to load.

2 Drag a sound from the computer hard drive to the white area in 
the sound Manager list.

3 Drag another sound to the white area in the sound Manager list. 

Files that are placed in the queue will be displayed in bold.

4 If you wish to cancel an ongoing queue, you can either delete all 
files that are queued or press the Cancel button. During the Clean 
process the Cancel option is not available.

Files waiting in the queue can be deleted from the queue if you change 
your mind. right-click on the queued sound or use the Toolbar or 
Menu Delete command.

 
 Files already in the instrument can be moved or deleted during the 
processing of the queue.

UPlOaD sOUnDs FrOM THe InsTrUMenT

1 select the desired partition that holds the sounds that you wish to 
store on the computer hard drive.

2 select the bank and the sound(s). shift-click will allow you to se-
lect several consecutive sounds; Ctrl-click will allow you to select 
nonconsecutive sounds. Here is a selection of a few programs:

3 Click the sound Up icon or right-click the selected sound(s) and 
select Upload. The dialog will prompt you to browse to the desired 
destination folder on the hard drive. The upload process may take 
a few moments depending on the size of the sounds.

PrOGraM/PerFOrManCe BUnDles

a Program/Performance Bundle contains one or several programs/per-
formances, and all the pianos and samples that these programs use, in 
one file. Bundles are great to store parts of the memory from your nord 
instrument. If you select one program and create a Bundle, the Bundle 
will be pretty small in size, and the uploading process will be reason-
ably quick, compared to a complete Backup procedure.

You can also create another Bundle with all the programs you need for 
a specific performance, and when you need those programs again, the 
Bundle functionality will restore them and their associated sound files to 
the nord instrument.

not all nord instruments are compatible with the Bundle feature. look 
at the sound Manager page on the nord website for further details.

Pianos and samples that are used by several programs will not be 
duplicated in a Bundle, nor will they be downloaded back to the instru-
ment if they already are in place in the instrument. 

 M Songs uploaded from a Nord Electro 5 or Nord Stage 3 are also 
uploaded as bundles, containing all referenced Programs and 
sounds.
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UPlOaD a PrOGraM BUnDle

1 Open the Program Tab and select one, or several programs. Use 
Ctrl-click to make non-consecutive selections like this one: 

2 Click on the Bundle Up icon in the Toolbar. 

The Program Bundle Upload dialog gives you two choices: 

Selection will create a Program Bundle with the selection of programs 
you made in the nord sound Manager program list and the pianos 
and/or samples that these programs use. 

Bank makes a Bundle of an entire Bank that you select with the 
drop-down. This action will probably take a bit longer and the resulting 
Bundle will be a bigger file since there may be many more pianos and 
samples in this type of Bundle. 

3 Choose the selection option and click on Upload. In the following 
dialog, give the Bundle a meaningful name and find a location on 
the computer hard drive. 

DOWnlOaDInG a BUnDle 

Here comes the really great part about Bundles. When you download 
a Bundle to the instrument, any pianos and samples that the programs 
in the Bundle depend on, are downloaded. They will be placed at the 
next available location in the piano and/or samp lib partition. 

 M Pianos and samples are not duplicated if these files are already in 
the instrument. The Bundle programs will use the new or existing 
locations of the pianos and samples, when they are downloaded 
to the free locations in the program partition. 

1 Make sure the Program Tab is open.

2 Press the Bundle Down icon in the Toolbar. You can also use the 
Bundle Download command from the File menu (Ctrl+shift+D). 

3 navigate to the Bundle file that you wish to download and click 
Open.

after the Manager has verified the files in the Bundle, the Program 
Bundle Download dialog will appear. 

 
 Click on Show Details if you want to see what programs, pianos 
and samples are in the Bundle. 

There are two options when you download a Bundle. 

Add to bank will download the program files and add them to the 
program bank that you choose in the drop-down menu. The programs 
will be placed at the first available locations.

 M If the programs in the Bundle will not fit in the Bank, the process 
will not be performed and you will see a message about this. 
Delete or move some programs from that Bank and try again.

Replace contents in a bank will simply delete all programs in the 
Bank you choose and download the programs in the Bundle to this 
bank instead. The programs will be placed at the same locations as 
they had when the bundle was created.

If a bundle will not fit in a bank, this will be presented in the dialog like 
in the image below where more free locations are needed in the 
program bank: 
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OrGanIZe THe PrOGraM ParTITIOn

By using drag and drop, you can organize the content of the Program 
partition(s).

1 Make sure that Organize is turned on in the view menu.

2 select and drag a program from the destination location to the 
desired location. 

If you drop a sound on a free location, the sound will be moved 
from the source location. If you drop it on a location that is oc-
cupied, the two sounds will change locations.

3 select a program and press the Ctrl-key on the computer key-
board. If you now drag this selection, the Program will be copied 
and pasted at the destination instead of just being moved. 

searCH BOx

By entering one or several characters in the search Box, you can filter 
out the content that is presented in the lists. 

This provides you with a quick way to find duplicate programs, etc. 

aUTO seleCT

By clicking on the auto select icon in the toolbar, you toggle the auto 
select function on or off. 

When auto select is turned on and you scroll 
through the pianos, samples or program lists using 
the computer keyboard arrow keys, the sounds will 
automatically be selected in the nord instrument.

 
 Double-clicking on a piano, sample or program will also make it 
active in the Nord instrument.

BaCKUP 

1 Click on the Backup icon to make a backup file that contains all 
the content in your nord instrument. 

The nord instruments are built 
to the highest standards of reli-
ability but doing regular backups 
is always a good thing.

2 Give the backup file a meaningful name and find a suitable loca-
tion on your hard drive.

 
 If you choose a backup file that already exists, only the changes 
that have occurred in the instrument will be added to that previous 
file. 

resTOre

When you want to restore the entire content of the nord instrument, 
click on the restore icon in the Toolbar and select a backup file that 
you have made. You can also drag the backup file from the computer 
and drop it to the Manager window. 

The Confirm restore dialog will appear that requires your confirmation. 
You can look at the content of the file if you click on “show Details”. 

There are Factory restore files available for all nord instruments, which 
can be used to restore the content of the instrument to that which it 
was shipped with. The files are available for downloaded from www.
nordkeyboards.com.
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sOUnD ManaGer reFerenCe

TOOlBar  

InFO

activating Info brings up an information area to the right of the list. 

The Info area will show if a selected piano or a sample is used in any 
Programs, or what pianos and samples are used in any selected 
Programs. This provides you with an excellent way of keeping track of 
how the content components in the nord instrument depends on each 
other.  

let’s say you need to delete some of the factory samples to make 
room for new samples. By selecting a sample in the samp lib partition 
and activating Info, you can see which of the programs that would be 
affected by such a deletion (or replacement).

OrGanIZe

When this option is active, the lists will show all the available locations 
in the selected partition/bank and not only the occupied ones. This will 
for instance make it possible to drag a file to a specific free location in 
the middle of the list. If this is inactive, only the occupied locations will 
be shown and re-arranging the order is not possible.

DUal vIeW

When this option is checked, the window (if set to display the Program 
partition) will be divided in two lists. You can make the lists show sepa-
rate banks with the drop-downs. rearranging programs is simply a 
matter of drag and drop. Drag a program from one bank/list to another 
bank/list in either direction.

aUTO seleCT

With this function active, scrolling through the piano, sample or 
program list with the computer keyboard arrow keys will automatically 
select the sound in the nord instrument.

renaMe

This allows you to rename a program. 16 characters can be used, and 
the supported characters are: a-z, a-Z, 0-9 and the hyphen (-). any 
other characters will not be displayed in the sound Manager lists.

 M Pianos or samples cannot be renamed so this function is not 
available if you have selected any of these.

DeleTe

allows you to delete one or several selected sounds. You will be asked 
to confirm your intentions. You may also use the delete or backspace 
key on the computer keyboard to perform this action.

 M Any Program in the Nord instrument that used a particular piano 
or sample that you deleted will probably not sound at all, since it 
will be missing an important component.

The space that a deleted piano occupied is not immediately available 
to other sounds, even though it is gone from the list and its location 
is free. The Flash memory needs to be cleaned to free up the space 
where the deleted sounds have been. When you add a new piano 
the cleaning process will be initiated automatically. You also have the 
option to manually start the cleaning process with the Clean Deleted 
space command from the File menu.

 M Flashing LEDs in the Piano Type and Model section indicates that 
the piano that the current program tried to use is not available in 
the Nord instrument memory. Select another program or down-
load the missing piano to the Nord instrument.

sUBsTITUTe

substitute allows you to replace a selected piano or a sample with 
another piano or sample that you have on the computer hard drive. 

This function is not only about replacing the sound file in the memory, 
all the programs that used the old sound, will be updated, relinked to 
use the new sound instead. 

relInK

Use the relink feature if you want one or several selected programs to 
use another piano or sample instead of the current sound. The sound 
in question have to be present in the memory of the nord instrument. 
relinking can also be used if a piano or sample is absent in the nord 
instrument, to repair the programs that are missing a component.

 M Not all Nord instruments are compatible with the Substitute and 
Relink features. In these cases the toolbar icons will be grayed 
out.
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sOUnD UP

Use this function to upload one or several sounds from the nord 
instrument to the computer hard drive. 

The sound Up dialog allows you to choose either the current selection 
of sounds or an entire bank. 

Clicking Upload brings up a file dialog where you select a location for 
the files on the computer hard drive.

sOUnD DOWn

Use sound Download to download one or several sounds from the 
computer hard drive to the next available location in the selected parti-
tion. 

The sound Down dialog gives you a few choices regarding the source 
files and their destination. 

source Files is the option when you want to browse for, and select 
individual files on the computer hard drive. 

source Folder is the option when you want to browse for and select 
an entire folder that contains sounds; all of the folder content will be 
downloaded to the instrument.

 M The files in the folder have to be of the same kind.

Destination add to bank will add the selected source files to the bank 
you select in the drop down menu. If the number of source sounds 
does not fit in the destination bank, a message will appear. 

Destination replace the content in bank will delete all the sounds in the 
selected bank in the instrument and replace those with the source files.

show Details will list the source files before they are downloaded to the 
instrument.

BUnDle UP 

This function will upload a selection of programs or an entire Bank to 
the computer hard drive, and include all the pianos and/or samples 
that these programs use in a Program Bundle file. 

The default source will be the currently selected Program(s) or the ac-
tive bank, but you can choose another bank with the drop down menu. 

Click on the Upload button to enter the name of the Bundle and to 
select the destination on the hard drive. The Program Bundle file that is 
created on the hard drive will have a file extension that ends with “pb”.

BUnDle DOWn

This function will download a Bundle with programs, pianos and 
samples from the computer hard drive to the nord instrument. You 
have a choice if you want the Bundle to be appended to the existing 
programs in the bank in focus or if the Bundle should replace the 
contents in an entire bank of your choice. 

Programs in a Program Bundle will be downloaded to the locations 
where they came from if the replace option is selected. 

 M Not all Nord instruments are compatible with the Bundle feature. 

BaCKUP

This will make a backup of all the pianos, samples, programs, and in 
some instruments also the live programs and the menu settings. Back-
ing up the entire memory content in this manner will take some time, 
depending on the sizes of the pianos and samples installed.

 
 Backing up from the Nord Sound Manager is done in an incre-
mental manner. Unless you change the name or the location of 
the backup file, only the pianos and/or programs that have been 
changed since the previous backup will be saved.
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The nord sound Manager will suggest a location for the backup the 
first time this function is selected (in My Documents/nord sound Man-
ager files/). If you’d rather save the backup file elsewhere, use the file 
dialog to pick another destination.

resTOre

To restore a previously saved backup file to the nord instrument, select 
this option and browse to a backup file on the hard drive and click 
Open.

 E The restore process will begin after you have clicked Open and 
confirmed your intentions in the dialog. All the content that isn’t in 
the backup file in a connected Nord instrument will then be irrevo-
cably replaced by the content in the backup file.

MenUs
The usual Windows and Mac Osx keyboard commands can be used 
in the nord sound Manager. The menus can be accessed by pressing 
the alt key and the underlined letter in the menu bar. 

Most of the commands can also be accessed by pressing the Ctrl (on 
the Mac - Command) key together with the letter shown next to the 
command name in the menus.

FIle MenU 

sOUnD UPlOaD 
(CTrl+U)

Use this function to upload 
one or several sounds from the 
nord instrument’s memory to 
a folder on the computer hard 
drive.

sOUnD DOWnlOaD 
(CTrl+D)

Use this function to download one or several sounds from the com-
puter hard drive to the next available location in the selected partition. 

look at page 8 for a detailed description of sound Up and sound 
Down.

PrOGraM BUnDle UPlOaD (CTrl+sHIFT+U)

This function will upload a selection of programs or an entire Bank to 
the computer hard drive, and include all the pianos and/or samples 
that these programs use in a Program Bundle file. 

The default source will be the currently selected program(s) or the ac-
tive bank, but you can choose another bank with the drop down menu. 

Click on the Upload button to enter the name of the Bundle and to 
select the destination on the hard drive. The Program Bundle file that is 
created on the hard drive will have a file extension that ends with “pb”.

PrOGraM BUnDle DOWnlOaD (CTrl+sHIFT+D) 

This function will download a Bundle with programs, pianos and sam-
ples from the computer hard drive to the nord instrument. You have 
a choice if you want the Bundle to be added to the existing programs 
in the bank in focus or if the Bundle should replace the contents in an 
entire bank of your choice. 

 M Not all Nord instruments are compatible with the Bundle feature.

BaCKUP (CTrl+B)

This will make a backup of all the pianos, samples, programs, perfor-
mances, live programs and the menu settings in the nord instrument. 
Backing up the entire memory content in this manner will take some 
time, depending on the sizes of the pianos and samples installed.

 
 Backing up from the Nord Sound Manager is done in an incre-
mental manner. Unless you change the name or the location of 
the backup file, only the pianos and/or programs that have been 
changed since the previous backup will be saved.

The nord sound Manager will suggest a location for the backup, 
the first time this function is selected (in My Documents/nord sound 
Manager files/). If you rather keep the backup file elsewhere, use the 
browser to pick another location.

resTOre (CTrl+r)

To restore a previously saved backup file to the nord instrument, select 
this option and browse to a backup file on the hard drive and click 
Open.

 E The restore process will begin after you have clicked Open and 
confirmed your intentions in the dialog. All the content of a con-
nected Nord instrument will then be irrevocably replaced by the 
content of the backup file.

Clean DeleTeD sPaCe

This function will clean up the space where any previously deleted pia-
nos or programs have been. This is done in order to make this deleted 
memory space available to new additions.

 M Cleaning is automatically done if you download a new piano or 
program to the Nord instrument, but this menu command makes 
it possible to manually start the cleaning process.

FOrMaT

This command will format the entire partition that is in focus. all the 
sounds in the partition will be deleted. You will be asked to confirm the 
operation before it is performed.

exPOrT sOUnD lIsTs

The export command will create a set of text-based lists of the content 
in the instrument, saved to location of your choice. The number of lists 
created depends on the type of instrument. The lists contain informa-
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tion with the names, locations and sizes of pianos and samples, the 
program list also contain information of which piano and/or samples 
are used for every program in the instrument.

The lists are formatted in a .html format. Double-click on a list to view it 
with a web browser, an application that probably can print them for you 
as well. The lists can be opened with a spreadsheet application, if you 
wish to perform further manipulation.

exIT (CTrl+Q)

exits the nord sound Manager application.

eDIT MenU 

renaMe (CTrl+n)

This allows you to rename a pro-
gram, performance, synth preset or 
song depending on the capabilities 
of the connected instrument.

16 characters can be used, the sup-
ported characters are: a-z, a-Z, 0-9 
and the hyphen (-). any other characters will not be displayed in the 
sound Manager lists.

 M Pianos or samples cannot be renamed so this function is not 
available if you have selected any of these.

In the rename dialog, a category can also be set for the selected item.

DeleTe (Del)

allows you to delete a selected item(s) from the nord instrument’s 
memory.

 E A dialog will appear with information if this action will affect any 
programs in the Nord instrument, that uses these sound. You will 
be asked to confirm your intentions.

sUBsTITUTe (CTrl+T)

This allows you to replace a selected piano or a sample with another 
piano or sample that you have on the computer hard drive. This will 
also change all programs that used the previous sound, to the new 
sound instead.

relInK (CTrl+K)

Use the relink feature if you want one or several selected programs to 
use another piano or sample instead of the current sound. The sound 
in question have to be present in the memory of the nord instrument. 
relinking can also be used if a piano or sample is absent in the nord 
instrument, to repair the programs that are missing a component.

 M Not all Nord instruments are compatible with the Substitute and 
Relink features, in which case these items will be grayed out.

seleCT all (CTrl+a)

select all items in a bank/partition.

InverT seleCTIOn

This will deselect the original selection and then select all the other 
items in the list.

vIeW MenU 

OrGanIZe (CTrl+O)

When this option is checked, the lists 
will show all the available locations in 
the selected partition/bank and not 
only the occupied ones. This will for 
instance make it easier to drag a file 
to a specific free location in the middle of the list. If this is unchecked, 
only the occupied locations will be shown.

DUal vIeW (CTrl+l)

When this option is checked, the window will be divided in two lists. 
The two lists makes it easy to move programs from one location to 
another. You can make the lists show separate banks with the drop-
downs. rearranging programs is simply a matter of drag and drop. 
Drag a program from one bank/list to another bank/list in either direc-
tion. 

 
 Press the Ctrl-key on the computer keyboard before dragging to 
copy a selection to the destination during a drag and drop opera-
tion.

InFO (CTrl+I) 

activating Info brings up an information area to the right of the list. 

This area will show if a selected piano or a sample is used in any 
programs, or what pianos and samples are used in any selected 
programs. 

FInD CTrl+F

This is a shortcut to the search Box. By entering one or several charac-
ters in the search Box, you can filter out the content that is presented 
in the lists.
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aUTO seleCT

When this function is active, pianos, samples or programs will be auto-
matically selected in the nord instrument when you browse through the 
sounds in the Manager list, with the computer keyboard arrow keys.

HelP MenU

aBOUT

Brings up the about box with a information regarding the version of the 
nord sound Manager. You will also see a list of compatible instruments 
and Os versions.

TaBs

PIanO – saMP lIB - PrOGraM - PerFOr-
ManCe - seT lIsT - sOnG lIsT

Use the tabs to select the desired partition. The drop down menu is 
used to select the desired bank within the selected tab/partition. The 
content of the partition will be presented in the list. note that not all 
instruments will show the same number of tabs.

 
 Press the Ctrl + Tab keys on the computer keyboard to cycle 
between the tabs.

searCH BOx

enter a phrase to quickly shown any pianos or programs that contains 
the characters in their names. Press Clear to clear the filtering and 
show all entries again.

lOC - lOCaTIOn

The banks are organized in locations; the number of locations varies for 
the different bank types.

naMe

The name of the item. The rename feature can be used to assign 
other names to editable content such as Programs, Performances, 
synth Presets and songs (see opposing page for details).

sIZe

shows the file size of the pianos and samples. This may be useful if 
you need to know how much space for example a particular piano oc-
cupies in the piano partition. This unit is not shown in the program lists.

ver – versIOn nUMBer

This indicates the version number of the actual piano, sample or 
program format. Older Os versions may not be able to use sounds in a 
newer format.

nOTe

This area contains various information messages regarding the memory 
content in the nord instrument. If a piano or sample is not used by any 
of the programs, it will be indicated here. This area is also used to alert 
you if a piano or a sample that a program in the nord instrument would 
use, is missing from the instrument. 

On a rare occasion that something happens with any of the files in 
the instrument, error information about broken, corrupted or rejected 
files, will be displayed here. If this happens, delete the broken file and 
download it again to the instrument.

FOOTer area

The footer area is located at the bottom of the nord sound Manager 
window. 

ParTITIOn MeMOrY InDICaTOr

This indicates the usage of the selected partition’s memory. The dark 
area shows the used memory and the brighter area indicates space 
that is available for additional sounds.

CanCel BUTTOn

Use this function if you need to cancel a process that is in progress. 
Certain actions like a restore process cannot be cancelled once they 
have been started.

PrOGress Bar

The progress bar indicate the progress of an ongoing process.

MessaGe/TexT area

The left part of the text area will present any confirmations or error 
messages from the nord sound Manager.

The right part will indicate of a nord instrument is connected to the 
computer and in communication with the nord sound Manager. The 
Os version of the connected nord instrument will also be displayed 
here.

UPDaTes anD sOUnDs

Please visit our website at http://www.nordkeyboards.com to down-
load any updates of the nord sound Manager and sounds that have 
been released for the nord instrument. These items will be available as 
free downloads in the Download area and in the libraries areas.
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